
 
 
17-5.02-P Workstation Tools 17 5.02-P 
 
UTILIZE the following tolls using a CG standard workstation, as presented in the E-PME 
Study Guide. 
 

• CG Forms Adobe PDF 
• Publications and Directives 
• Fed Log 
• CGMS 
• Direct Access 

 
Workstation Tools As a Coast Guard member, you will often need to use the Coast Guard 

standard workstation.  It addition to Microsoft Office, the workstation 
provides access to work tools such as: 
 
• CGForms.pdf 
• Publications and Directives 
• FED LOG 
• CG Message System (CGMS) 
• Direct Access 
 

 
CGForms.pdf A significant number of forms are available that can be accessed from the 

Coast Guard standard workstation (Intranet).  To access these forms from 
the Intranet and utilize them: 
 
1. Log on to the workstation as a ‘User.’ 
2. Select Start | Programs | USCG Applications | USCG Forms. 
 
The program will open USCG Electronic Forms System on the CG 
Intranet.  The USCG Electronic Forms System screen has three options: 
 
• Forms library box—If you know the form series (e.g., 3000 series), 

enter it and search a list of all of the forms in that series. 
• Form Number—If you know the exact number of the form, enter it 

and go directly to it. 
• Form Title—If you know the exact form title, enter it and go directly 

to it. 
 



CGForms.pdf 
(continued) 

An Internet version is also available.  To access the electronic forms from 
the Internet go to: 
 

http://www.uscg.mil/ccs/cit/cim/directives/welcome.htm
 

From this screen, select the forms you want from the listing or enter a 
query in the box at the bottom of the screen. 
 

 
Searching Under 
the Forms Library 
Function 
(CG Intranet) 

 

Entering a key word, such as “Administrative,” displays a listing of all 
forms containing that keyword.  The forms are organized into three 
categories of information: 
 
• Forms library 
• Form number 
• Title 
 
Scroll through the list until you find the one you need.  Select the form, 
then select the arrow on the document’s left to access the form. 
 

 
 

 

http://www.uscg.mil/ccs/cit/cim/directives/welcome.htm


Coast Guard 
Forms Internet 
Search 

From the USCG Electronic Forms screen, select the category of forms 
from the choices listed or enter a query in the box at the bottom of the 
screen. 
 
After selecting the category, scroll down and select the exact form you 
need. 
 

 
 
Publications and 
Directives 

The Coast Guard has made all their policy documents, or directives, 
available online to all personnel.  Previously, all Coast Guard units kept 
paper copies of the material.  
 
The Coast Guard Directives System is available on the CG Intranet at: 
 

cgweb.uscg.mil/g-c/g-ccs/g-cit/g-cim/directives/welcome.htm 
 

OR on the worldwide web at: 
 

www.uscg.mil/ccs/cit/cim/directives/welcome.htm. 
 
You can also access directives on your computer by selecting the 
following options in the order shown: 
 
• Start 
• Programs 
• USCG program Apps 
• CG Directives 
 

 

http://www.uscg.mil/ccs/cit/cim/directives/welcome.htm


Directives A directive is a written communication that initiates or governs action, 
conduct, or procedure.  Five main types of directives are issued.  They are 
listed below with their abbreviations. 
 
• Instructions (INST) 
4 Contain information that has continuing reference value or that 

requires continuing action. 
4 Remain in effect until replaced or canceled by the originator or 

higher authority. 
4 Review and validate by originators every four years. 
 

• Manuals (M) 
4 Permanent type of instruction 
4 Contain 25 or more pages 
4 Have a table of contents and are organized into chapters and 

sections 
4 Are reviewed annually by originators and canceled when no longer 

applicable 
 

• Message-Type Notices 
4 Notices (NOTES) transmitted via the Coast Guard Message 

System (for example, an ALCOAST message) 
4 Urgent in nature (Urgency is defined as insufficient time to publish 

as another type of directive.) 
4 Provide information required by law or regulation, an issue of 

safety, or important to the morale of Coast Guard personnel (for 
example, announcement of award winners, promotions, selections, 
etc.) 

 
 • Notices (NOTE) 

4 Contain information of a one-time or brief nature 
4 Same force as an Instruction 
4 Automatically cancelled after 12 months if earlier cancellation 

date not specified 
 

• Standard Operating Procedures (SOPs) 
4 Set of instructions for operations that lend themselves to definite 

or standardized procedure 
4 For internal procedures at a unit 
4 Have no defined format 

 
 



Originators of 
Directives 

 

The four main originators who issue directives are: 
 
• The Commandant 
• Area, District, and Group Commanders 
• Commanders of Maintenance & Logistics Commands 
• Commanding Officers and Officers in Charge 
 

 
Identifying 
Directives 

 

Let’s look at the components of the following directive: 
 

 CG Personnel Manual, COMDTINST M1000.6A 
 
• COMDT—The Originator...in this case, is the Commandant. 
• INST—Type of Directive...in this case, is an Instruction. 
• M1000—The “M” before the number means that this is a Manual.  

The number is the Standard Subject Identification Code (SSIC).  In 
this case, 1000 means “Military Personnel.” 

• 6A—The “6” after the period means that this is the sixth directive to 
use this Standard Subject Identification Code (SSIC), in this example, 
the sixth directive to use the SSIC, “1000.” The “A” stands for a 
rewritten or revised directive.  Originals do not have letters.  In this 
case, the “A” means that it is the second version of this directive.  “B” 
would indicate the third version. 

 
 
A Directory of all 
Directives 

An important resource that can help you find directives is the Directives, 
Publications, and Reports Index (Commandant Notice 5600).  This index, 
published annually, lists all current Coast Guard directives. 
 
• Chapter Two lists all directives numerically 
• Chapter Three lists them alphabetically 
 

 To view Commandant Notice 5600, Directives, Publications, and 
Reports Index, select this (untestable) link: 
 

http://www.uscg.mil/ccs/cit/cim/directives/cn/cn_5600_2004_3_29.pdf
 

 
This content is not testable.  It is provided for your personal use only. 
 

 

http://www.uscg.mil/ccs/cit/cim/directives/cn/cn_5600_2004_3_29.pdf


FED LOG FED LOG is a searchable logistics information system that contains 
information from the Federal Logistics Information System (FLIS) 
databases. 
 
The system allows users to locate management, part number, supplier, 
freight, and characteristics data for a National Stock Number (NSN) or, 
conversely, find an NSN to go with any of the other pieces of information. 
 
Currently, FED LOG contains the data found in the following federal 
sources: 
 
• Master Cross Reference List 
• Management List 
• DoD Interchangeability and Substitutability 
• Freight Classification Data 
• Identification Lists (formally 295 separate list publications!) 
• Parts of the Federal Item Logistics Data Record 
• Federal Item Name Directory 
• Federal Supply Classification Cataloging Handbook H-2 
 
FED LOG also contains listings from the various military branches. 
 

 



FED LOG User’s 
Manual 

The user’s manual provides detailed information about system features.  
Step-by-step instructions and examples guide you through each program. 
 
To access the User’s Manual, when FED LOG is open and active, click on 
the FED LOG User’s Manual button on the Button Toolbar or choose, 
“User’s Manual” from the Help menu. 
 
Some important features of FED LOG are: 
 
• Help.  Help for using the manual is available by pressing [F1] from 

anywhere in the manual or choosing Using the Manual from the Help 
menu.  You can print a copy of the help instructions for using the 
manual from within the manual help. 

 
• Appendices.  The appendices of the User’s Manual contain additional 

information, such as a list of function keys, a glossary of acronyms 
and terms, and a troubleshooting guide. 

 
• URL.  Also, in addition to the User’s Manual, the following 

(untestable) URL opens web pages that explain FED LOG, and lists 
the FED LOG frequently asked questions (FAQs), monthly 
newsletters, and more: 

 

http://www.dlis.dla.mil/FED LOG/default.asp
 

 While the information in the Users Manual is not testable, it is 
suggested that you read the manual to become familiar with other FED 
LOG features. 

 
 
Menu Bar The Menu Bar looks like this: 

 

 
 
The FED LOG Menu Bar is similar to many other software systems with 
which you are familiar.  Like other software programs, many of the 
choices on the menu bar are also available on the tool bar. 
 
Detailed descriptions are available in the User’s Manual for every item on 
each “drop-down” menu.  A brief summary has been provided for some of 
the items that are unique or of special interest when using FED LOG. 
 

 

http://www.dlis.dla.mil/FedLog/default.asp


File The Properties item on the Interactive File menu brings up a dialog that 
lets you set basic display and search properties, set up a custom-designed 
data-view, and set up a custom version of the NIIN pick list.  There are 
four tabs on this item: 
 
• Char Search 
• Options Custom 
• View Custom 
• Pick List 
 

 
 

 
Edit 

 
 

The Edit menu allows you to copy the information currently on-screen or 
all the information in the current view to the Windows clipboard. 
 

 
 

 



Service 
 
 

You have the option of limiting your searches based on service.  This 
means that search results must match the criteria you have entered on the 
Query screen and also must contain data specific to the service selected 
under the Service Filter selection on the Service menu. 
 
This feature is used specifically with the search feature of FED LOG. 
 

 
 

 
Dataviews The Dataviews menu offers selection of Dataview rotation and the ability 

to cross-reference between services.  There are three primary options 
listed below. 
 
• Select Views.  This option lists the standard data views available for 

all services, as well as service-unique views, depending on the service 
you selected. 

 
• Rotating Through Views.  From a data screen, you can view other 

data screens for the displayed record by choosing Previous View or 
Next View.  These keys scroll through the databases tagged in the 
“Select Views Window.” 

 



Dataviews 
(continued) 
 

• Sort NSN List.  The “Sort NSN List” option allows you to select a 
field, including custom data fields, with which to sort the NSN list. 

 
The Users Manual contains other (untestable) options. 
 

 
 

 
View 
 

When you are on a Dataview, you can change from service to service and 
see which views have data. 
 
You can also go to the View menu and look at the submenu for each 
service to see which Dataviews have data for the current search match. 
 

 
 

 



Help 
 

The Help menu contains information that can help you navigate through 
or troubleshoot problems with FED LOG. 
 

 
 

 
Related Web 
Links 
 

 

This is the last menu choice on the Menu Bar.  It provides links to other 
valuable resources. 
 

 
 

 



 
Toolbar The Toolbar in FED LOG looks like this: 

 

 
  

Procedures for logging onto FED LOG will vary from unit to unit. 
After logging into FED LOG, the Federal Logistics Information System 
(FLIS) Interactive Query window will display.  The FED LOG Toolbar is 
used to move through the system and make frequently-used actions. 
 

 
Summary FED 
LOG 

 
FED LOG is a CD-ROM based application, which runs on the CG 
standard workstation III.  The path to the CD-ROMs varies from unit to 
unit. 
 
For specific paths to FED LOG discs, contact your servicing: 
 

• Electronic Support Unit (ESU) 
• Electronic Support Detachment (ESD) 
• Local Systems Manager (LSM) 

 
Review and become familiar with the following tool bar job aid. 
 
For further (untestable) instruction on how to use FED LOG, go to the 
on-line tutorial or go to the on-line User’s Manual. 
 

 



Prepare a Coast 
Guard Message 
(CGMS) 

 

You may find yourself in a position where you are required to send a 
message through the Coast Guard Messaging System (CGMS).  There are 
specific requirements for how these messages are formatted.  This allots a 
minimum amount of characters to be used to convey a maximum amount 
of information. 
 

 
 
Format 
 

A generic format for messages is provided.  This format specifies the 
exact information that belongs on each line of the message. 
 

 Line # Content 

 1-4 AUTODIN Routing, Security warning, Transmission Release 
Code, Special Handling (not used on CG circuits) 

 5 Precedence, Date Time Group, Message Instruction 
 6 Message Originator (FM) 
 7 Action Addressees (TO) 
 8 Information Addressees (INFO) 
 9 Exempt Addressees (XMT) 
 11 Prosign BT 
 12 Message Text ( In specific order ) 
 13 Prosign BT 

 



Format 
(continued) 

The format for each message line is given below. 
 

• Line 1–4.  These codes are issued and completed automatically. 
 

• Line 5.  In Line 5, the message creator will enter, in the order 
indicated below, the: 
4 Precedence.  The “Precedence” entry must always appear first on 

Line 5.  It indicates when the message should be distributed, 
which is a direct function of the message’s urgency.  The 
Precedence entry indicates a Speed of Service Objective (SOSO) 
code.  This single-character code serves as general guidance for 
Communication Centers to process message traffic according to 
the precedence assigned.  The SOSO times indicate the time from 
which a message enters in, and then is transmitted out from an 
individual Communications Center.  Potential SOSO codes are: 
– Flash (Z)—As fast as possible, with a goal of 10 minutes 
– Immediate (O)—30 minutes 
– Priority (P)—3 hours 
– Routine (R)—6 hours 

 

4 Date Time Group.  The Date Time Group (DTG) is a unique 
fingerprint on each message.  It is the means to identify and locate 
a message if you are discussing it with another person or referring 
to a message within another message (e.g., replying to a message).  
The system ensures that no two messages have the same DTG.  
DTGs contain day, time, month, and year.  In the example 
271237Z JUN 00: 
– 27 stands for the day of the month 
– 1237Z is the time in Zulu (Greenwich Mean Time), followed 

by the month and last two digits of the year. 
 

4 Message Instruction.  This set of characters indicates any special 
circumstances related to the transmission of the message.  
Specifically, this set of characters will indicate if a message has 
been: 
– Corrected (ZOJn, where “n” is the number of the correction) 
– Retransmitted (ZDK, positioned after the date of the original 

message) 
– Administrative type (ZYB, follows the date time group) 

 
 



Format 
(continued) 

• Line 6.  In Line 6, the originator will indicate from where the 
message is being sent.  This entry will always begin with the code FM 
followed by the boat or facility name and the city and state of origin. 

 

For example, a message originating from the Cutter USCGC Sockeye, 
stationed in Bodega Bay, California, would contain the following 
Line 6: 

FM USCGC SOCKEYE//DT// 
 

• Line 7.  The “TO” line indicates the action addressee(s).  An action 
addressee is not mandatory as long as there is at least one INFO 
addressee.  There can be more than one action addressee. 

 

• Line 8.  The “INFO” line indicates the information addressee(s).  An 
INFO addressee is not mandatory as long as there is at least one TO 
addressee.  There can be more than one INFO addressee.  This is 
similar to copying a member on an email. 

 

• Line 9.  The “XMT” line indicates exempt addressees who are called 
in a Collective Address Designators (CAD), or Address Indicating 
Group (AIG). 
4 A CAD is a single address group that represents a predetermined 

set of five or more activities linked by an operational or 
administrative chain of command. 

4 AIGs are predetermined lists of action/information addressees 
controlled by a “cognizant authority” and used for messages 
containing information of a recurring or pre-planned nature. 

 

The originator may exempt one or more of the addressees from a CAD 
or AIG by listing them in line nine. 

 

• Line 11.  In Line 11, the originator includes the code BT to indicate 
that the body text for the message will begin on the following line.  
The originator will also include the same code in Line 13 to indicate 
the body text for the message is completed. 

 

 
 



Format 
(continued) 

• Line 12.  In Line 12, the originator composes the body text for the 
message.  The text in the message must be placed in the following 
order: 

 
A) Classification (Unclas, Confidential, etc.) 
B)  Special Handling (SPECAT, LIMDIS, etc.) 
C)  Special Delivery (NORFORN, ORCON) 
D)  Standard Subject Identification Code (SSIC) 
E)  Exercise Name (If Applicable) 
F)  Subject Line (Should be only one line of text) 
G)  References 
H)  Paragraphs 
 

 
Note that not every message will have all entries.  Skip entries if they 
do not apply, but they cannot be placed in a different order. 

 

• Line 13.  In Line 13, the originator includes the code BT to indicate 
the body text for the message is completed.  The originator will also 
include the same code in Line 11 to indicate that the body text for the 
message began on the following line. 

 

 
 



Format 
(continued) 

Here’s a sample message properly formatted for transmission. 
 

5  P 151515Z JAN 00 ZYB 
6  FM CCGDEIGHT NEW ORLEANS LA 
7  TO AIG FOUR SEVEN EIGHT NINE 
8  INFO COGARD TISCOM ALEXANDRIA VA//OPS- 
9  XMT USCGC EVERGONE 
11  BT 
 UNCLAS EFTO NORFORN //N02000// 
 EXERCISE EXERCISE EXERCISE 
12  SUBJ: MESSAGE DRAFTING COURSE 
 MY 151510Z JAN 00 
 MESSAGE TEXT 
13  BT 
 
CGMS automatically formats the message. 

 
There are some formatting requirements for the text within the report.  
The text: 
 
• Cannot contain tabs 
• Cannot be allowed to auto wrap at the end of the line 
• Must be limited to 69 characters per line 
• Can only contain approved characters 
 
The report must also contain a statement authorizing release of the 
message over the Internet, if appropriate.  This authorization must be 
formatted as “INTERNET RELEASE AUTH,” and the last line of the 
message text must be “Internet release is authorized.” 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Approved 
Characters 
 

ONLY the following characters have been approved for use in official 
record message traffic: 
 

Character Symbol 
Apostrophe ‘ 
Colon : 
Comma , 
Parenthesis ( 
Question Mark ? 
Quotation Mark “ 
Slant Bar / 
Hyphen - 

 

Period . 
 
 The “At Sign” @ may be used on Coast Guard messages only, but must 

be spelled out on messages going outside the organization or to ships that 
are underway. 
 

 
Message Types In CGMS, there are two types of messages: 

 
• Unclassified 
• Classified 
 
Classified and unclassified messages both have precedence.  A classified 
message in itself doesn’t indicate priority or that it has precedence (just 
that it’s classified).  Precedence, not classification, determines priority. 
 

 
Unclassified 
Messages 

An “UNCLASS” message is an “unclassified message.” These are 
information-type messages, such as reports, announcements, and 
Commandant messages.  They include: 
 
• ALCOAST.  Messages applicable to all Coast Guard commands, with 

blanket distribution to all Coast Guard units 
• ALCGOFF, for officers 
• ALCGENL, for enlisted 
• ALCGCIV, for CG civilians.  Messages that are originated by Coast 

Guard Headquarters in Washington, DC, and used in disseminating 
Coast Guard Civilian Personnel Information. 

 
 



Classified 
Messages 

A “class” message is a “classified message.” There are three categories: 
 

• Top Secret.  Top Secret information requires the highest degree of 
protection.  The unauthorized disclosure of top-secret information 
could reasonably be expected to cause exceptionally grave damage to 
national security. 

 

• Secret.  Secret information requires a substantial degree of protection.  
The unauthorized disclosure of secret information could reasonably be 
expected to cause serious damage to national security. 

 

• Confidential.  Confidential information requires protection.  The 
unauthorized disclosure of confidential information could reasonably 
be expected to cause damage to national security. 

 
 
Authorized Users Your unit’s command security officer or security manager will determine 

your “need to know” information level based on your job and your 
security clearance. 
 
Your need to know plus your security clearance equals your level of 
access to CGMS.  Once that is determined, follow your unit’s procedures 
for message traffic. 
 
Also, some units regularly clear out the message cache so that the system 
doesn’t become flooded.  Find out how it is handled in your location. 
 

 
 

 
Using CGMS Not all personnel will use the CGMS system.  You need to have read 

authority to view messages on CGMS.  When you log on to your 
computer, your password will display the messages that are appropriate 
for you to view. 
 
Once the messages appear, you can then determine the ones that are most 
appropriate for your job and only read the relevant messages. 
In order to send a message on CGMS (referred to as having release 
authority), you need special training on drafting messages. 
 

 



Direct Access Direct Access is the human resources management system for Coast 
Guard military personnel.  Coast Guard military personnel use it for 
payroll actions, requesting their next jobs (assignments), evaluations, 
training, and more. 
 

 
Direct Access 
Functions 

In order complete the following functions in Direct Access, you need to be 
on-line: 
 

• Enter your e-mail address 
• Change your password 
• Set a password hint. 
 

 
Use Direct Access In order to use Direct Access, you will need your Employee ID number 

and Social Security number the first time you log on. 
 
To find your Employee ID number, contact your unit’s administrative 
staff.  Your Employee ID number will be available to them sometime 
between one week and one month after you begin employment with the 
Coast Guard. 
 
To use Direct Access from your Coast Guard computer: 
 
1. Open Internet Explorer. 
2. Type in cgweb.uscg.mil/g-w/psc/Direct-Access/. 
3. Click on the yellow “Sign In” button for “Self-Service Users.” 
 
The PeopleSoft login screen will appear.  (PeopleSoft is the company that 
created Direct Access.) 
 

  
 

 4. Type in your User ID (Employee ID #) and your Password (SSN #). 
5. Click on the “Sign In” button. 
 

 
 



Enter Information 
into Direct Access 

To do the following tasks, view the online instructions and demonstrations 
at the web addresses below each task: 
 
1. Enter your e-mail address 

 (www.uscg.mil/hq/psc/cghrms/vids/Signin.htm) 
 

2. Change your password 
 (www.uscg.mil/hq/psc/cghrms/index.htm) 
 

3. Set a password hint 
  (www.uscg.mil/hq/psc/cghrms/vids/pw.htm)
 

 

http://www.uscg.mil/hq/psc/cghrms/vids/Signin.htm)
http://www.uscg.mil/hq/psc/cghrms/index.htm
http://www.uscg.mil/hq/psc/cghrms/vids/pw.htm)
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